Mendeley Help
Guide

What is Mendeley?
Mendeley is freemium software which is available across a number of different
platforms. You can run Mendeley on your computer or laptop, as an app on your
phone or tablet, and also access it from your web browser. Mendeley’s Desktop
application allows you to organise, collaborate and discover, as well as use the
citation plugin to cite as you write in Microsoft Word or LibreOffice. While the web
and mobile apps offer you the ability to access your references on the go, as well
as making notes and annotations.
Mendeley acts as a
Getting Started
repository
for
your
reference information. You
The first thing you’ll need to do is to create an
add papers to your library
by importing PDF files
account via http://mendeley.com. This is free to do
stored on your computer,
and only takes a few seconds.
or by retrieving them from
other locations like Library
databases such as EBSCO, ScienceDirect, Pubmed or PLOS. You can also create
entries for items that you don’t have access to as PDFs by manually entering
details. Materials you add to your library are then stored in the cloud, for you to
retrieve wherever you need them. It might be that you want to add a paper to your
Library while using the campus Wi-Fi, and then cite it while writing your paper at
home later that day. Mendeley allows you to retrieve the same resources with the
same enhancements and annotations wherever you need them.

Mendeley Desktop

You’ll need a Mendeley account to log into the different versions of the software.
Once you’ve created your account you’ll be prompted to download the appropriate
version of Mendeley Desktop for your current machine. You don’t have to do this
right away, but it’s a good idea to have the desktop application installed on your
main working computer.
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Mendeley Desktop uses a
three column structure.
The left- hand panel
When you first open Mendeley Desktop, you’ll
allows you to navigate
need to log into your Mendeley account. This
through different filtering
options for your library.
ensures that any changes you make are being
When you click on
made to your own account and will be carried
different folders or groups
listed in this column,
across when you log into different devices.
different lists of papers
will be returned in the main panel. In this screenshot we have ‘All Documents’
selected, which means the main panel is listing all of our references.
Mendeley Desktop

The middle panel allows you to select individual references. Clicking on a
reference listed here will display this document’s details in the right-hand panel.
You can also select multiple papers to undertake bulk actions, such as mass
deletions or additions to folders.
The right panel shows the details of your selected reference. You can also use
this panel to modify the details by clicking into the individual fields. You should
carefully check and correct the details displayed in this panel as ensuring
accuracy here will ensure that your citations are totally correct.
Mendeley Web is the version of Mendeley accessible via your web browser. You’ll
need to be logged into your Mendeley account in order to access it. The layout is
similar to Mendeley Desktop (the same three-column setup) although it has been
optimized for use in a browser.

References and Documents
Mendeley deals in both
documents and
Document versus Reference
references. It will take a
In Mendeley, a document means an actual file,
document - in the form of
a PDF paper - and
usually a PDF version of a research paper, while a
attempt to extract the
reference is the simple information needed to cite
reference information in
order to produce a
a document.
reference. It does this by
looking at the contents of
the paper, and by examining any included metadata. You can then check and
modify this reference data to ensure that Mendeley has produced the correct
details. Ensuring you have correct reference details is very important!
It’s also important to realise that you can have a reference without providing a
document. If you know the details of a publication (such as the author, title etc.)
you can still add it to your library and cite it - even if you don’t have access to a
PDF version.
This can be useful if you’re citing a book that you use in hard copy, for example.

http://my.napier.ac.uk/Library/

http://staff.napier.ac.uk/Services/Library/

Adding Documents and References
Mendeley also offers a
Saving it is easy!
number of other options
for adding material to your
Certain online catalogues, such as ScienceDirect
library. You can find these
allow you to export references directly to
by opening the File menu.
You can choose to add
Mendeley. Look out for the Export button on pages
individual files, or the
like this.
contents of an entire folder
by browsing to the relevant
location on your computer. You can opt to ‘watch’ a folder - which will mean that
Mendeley monitors that location for any new items being dropped into the folder. If
it finds a new document, that document will be automatically added to your
Mendeley library. You also have the option to create a reference manually - which
will allow you to complete a number of fields by hand.
You can also easily import or export your library to and from other reference
managers. So if you would like to switch between Mendeley to Endnote, to Zotero,
to RefWorks for example, you can do so easily. The Web Importer is a bookmarklet
that you can add to your web browser. The bookmarklet will detect references on
the page you’re viewing and ask if you want to add them to your library. You can
also use it to add web pages to your library.
Mendeley also operates a database of publications sourced from records created
by its users. This allows you to search the online and identify references you want
to add to your library with just a few clicks. Other catalogues will allow you to
export in file formats such as RIS, which can then be added to Mendeley using
the File menu.

You may find that after collecting a library of references over time that you have
accumulated some duplicate entries where two or more copies of the same
reference or document exist. Fortunately fixing this is easy. Use ‘Check for
Duplicates’ found in the Tools menu to identify any duplicate entries and merge
them into a single, combined entry.
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Manage Your Library
Mendeley Desktop’s interface should be fairly intuitive if you’re familiar with
programs like iTunes, or even Gmail. The left-hand panel offers a number of
different options to help filter your document list to exactly what you need to find.
The default position when
opening Mendeley
Desktop is ‘All
Because your Mendeley account works on
Documents,’ which will list
different devices, whenever you make changes to
all items in your library.
You can use the column
your Library, you’ll need to sync in order to push
headings (such as Author
those changes up into cloud storage. It’s a good
Names, Year, etc.) to
order your documents by
idea to sync regularly to ensure that your
that value which can be
documents and annotations are saved.
useful for finding works by
a specific author, for
example. When you add materials to your library, they will initially be marked as
unread, indicated by a large green dot in the second column. You can toggle this
off and on by clicking it. Alternatively, a document will be marked as read once
you’ve spent a certain amount of time reading it in the Mendeley PDF reader. You
can ‘star’ documents to mark them as favourites. They can then be easily
retrieved via the left-hand panel. You can also use the left-hand panel to access
items you’ve recently added, or items you’ve recently read.
Sync

Another way to manage and organise your Library is to use tags and notes. You
can add multiple tags to your references using the document detail panel when
you have the reference selected. Then it is a simple matter of using the Filter by
My Tags menu which appears in the bottom left corner to quickly pull up materials
that you’ve tagged.
Folders and subfolders allow
you to quickly file your
references under different
topic headings. You can drag
and drop references from
your library onto the folder
name in the left panel to add
that reference to a folder.
To find items in your Library
just enter your search term in
the field which appears in the
top
right
corner
and
Mendeley will filter your current view to show references which contain that term. It
will also search within the full text of PDF papers which appear in your library. The
search is context specific, so if you’re not getting the results you expect make sure
that you have the appropriate folder selected in the left-hand panel. If in doubt,
select ‘All Documents’. Use the ‘clear’ button which appears on the yellow toolbar
to remove the search filter.
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PDF Viewer and Tools
The Reader’s layout will be familiar if you’ve used Adobe Acrobat or similar
software. Clicking on the PDF icon next to a document opens it up in a new tab.
Mendeley will remember where you were up to in a paper when you open it and
take you back to the same place. At the top of the screen you’ll see a number of
tools, which are mostly self-explanatory.

You can also add notes to
Highlighting Text
the paper to help organize
your thoughts. These can
You can highlight important passages using the
be done either in the Notes
Highlight tool just as you would when reading a
box which appears in the
document detail panels, or
physical copy. This allows you to pick out
you can add ‘sticky notes’
important passages from a paper.
to a particular passage in
the document. Notes in the
Notes box are document-wide and can also be viewed from the main library view without opening the paper for reading. While Sticky notes that are added in this way
will appear in the list of annotations in the document details panel. You can use
these entries to jump to the appropriate location within the paper.

Citation Plugin
To use the plugin first positioning your cursor where you want the citation to
appear and then clicking on the ‘Insert Citation’ button which appears under the
Reference tab. You also need to be running Mendeley Desktop, and will be
prompted to start it if it is not currently running.
Pressing the button will
open the Mendeley
search tool. This box
To install the citation plugin, select ‘Install MS
allows you to enter a
Word Plugin’ from the Tools menu within
term, such as an author
name, before returning
Mendeley Desktop. Once installed, the citation
search results from your
plugin will appear within Microsoft Word under the
library. Locate the
reference you want to
References tab.
cite, click to select it and
press the Ok button. You will see that the citation is added. Its appearance will
vary depending on which citation style you currently have active at the time.
Installing the Plugin

If you’re looking for a particular citation and can’t remember its details you can
also opt to switch to Mendeley desktop to locate it using search or filtering by
tags, for example. Just press the ‘Go to Mendeley’ button to switch over to that
interface. Once you’ve located the appropriate reference, click to highlight it and
press the ‘Cite’ button which temporarily appears on the Mendeley Desktop
toolbar. If you want to cancel the citing process and return to your manuscript
press the cancel button.
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Note that your document is considered ‘locked’ while this process is active. You
need to cancel the citation to return to the document, or insert a citation before
you can switch back to writing your assignment.
Once you’ve done adding citations you’ll need to generate a bibliography. Ensure
your cursor is positioned where you want your bibliography to appear and press
the ‘Insert Bibliography’ button - it just takes one click! All the references used as
part of your work will now appear as a list. They will be ordered depending on
whichever citation style you have chosen to use.

Citation Styles
Citation Styles determine how your references appear, both in the text of your work,
and in the bibliography. Different disciplines will use different styles. In Mendeley
you change the citation style very easily. To do so, open the styles dropdown menu
which appears on the
Mendeley toolbar.
Over 1,600 citation styles
If you still can’t find the
If you don’t see the style you need, you can click
right style or you’d like to
‘More Styles’ to be taken to the Styles tool within
customize an existing
style, you may want to try
Mendeley Desktop. This will also allow you select
the Mendeley CSL Editor,
from over 1,600 different styles; including the most
which allows you to
customise citation styles.
commonly used such as APA, IEEE, OSCOLA etc.
You can also share
created styles with other
Mendeley users. The editor can be found at http://csl.mendeley.com

Create or Join Groups
If you are interested in sharing your Library with others, for a group assignment for
example, then using Mendeley’s Group function might be useful. Any groups that
you are a part of will be listed in the left panel of Mendeley Desktop, underneath
your personal folders. To add materials to a group, just drag and drop them onto
the group name. Because Mendeley is a freemium service, users with a free
account will only be able to add three people to their groups. If you would like to
add more people to your group you will unfortunately need to pay for a ‘Team
Plan.’
You can create new groups at any time by using the ‘Create Group…’ option.
Mendeley offers three different types of group:
Open: these groups are publicly visible and accessible to anyone. They will be
listed in the groups’ directory on Mendeley’s website. Members can add
references to the group but only the reference details will be added.
Invite-only: these groups are publicly visible, but membership is controlled by the
group admins. Anyone can ‘follow’ the group to access the references, but only
full members can add or edit references.
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Private: these groups are not publicly visible. Members need to be invited.
Members can share full-text papers with each other, and can also collaboratively
highlight and annotate on these materials. Each contributor will be assigned a
colour to help distinguish their changes.
Mendeley has a community of public groups devoted to all kinds of disciplines.
You can browse for groups in your subject and join or follow them in order to keep
up to date and make contacts.

Create your Research Profile
You can use Mendeley to share your work with other users by adding your
publications to your personal profile. You can add all kinds of publications;
working papers, poster presentations, journal articles etc. Adding publications will
make them available to other users via your profile, as well as connecting you to
them in the Mendeley
Web Catalogue. If other
Share Your Interests
users view your paper in
the Catalogue, they will
Completing your profile is a great way to promote
see that you are a
yourself and to encourage other users to get in
Mendeley user and will be
able to connect with you.
touch. You can use your profile to share as little or
To add your personal
as much of your information as you like.
publications, open ‘My
publications’ in Mendeley
Desktop, and either drag and drop a file onto the specified area, or click to browse
to a file on your computer.

Literature Search
If you know the name of a paper or if you have a specific topic in mind, you can
use the Literature Search setting from within Mendeley Desktop. As the Catalogue
is crowd-sourced, the Literature Search can only retrieve papers that have already
been added by other users.
So if the article you want is
very new or obscure, it
might not show up.
If the full text of a paper is
available (if the paper is
open access for example)
you’ll see an icon allowing
you to download it. You can
also search the catalogue
online via mendeley.com’s
Papers tab. If you’re logged
into your Mendeley
account, you’ll be able to
save the resulting
references straight to your
library.
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Who else is reading this?
A

Web

Catalogue

entry

will

also

include

readership statistics drawn from Mendeley. You
can see the number of people who have read the
paper, as well as a breakdown of their discipline
background.

When viewing a web
catalogue entry, you’ll see
the option to add the
reference to your library
with just a single click. If
the paper is freely
available (again, open
access is a good
example) you’ll also be
able to download the full
paper. For other
references, you can use
the ‘Find this paper at’
dropdown menu to view
different options. Using
Open URL will allow you
to retrieve a paper
through your institutional
access, providing your
institution has the
appropriate subscription.

When viewing a paper in
the Web Catalogue, you’ll also be given a list of papers that are related to it. These
relationships are determined by the behaviour of other Mendeley users, so if a
paper is commonly used in conjunction with the item you’re viewing, it will be
recommended to you.
Finally, from within Mendeley Desktop you can select multiple papers within your
library, and right click to be given a list of papers connected with the items you
selected. This can allow you to discover new resources connected to a set of
materials and can be handy for finding niche topics or interests.

Where to From Here?
You can contact the Library for help with Mendeley at any time. Mendeley’s
Resource Centre also has a selection of detailed guides for each of the different
versions, as well as feature guides and video tutorials that cover specific
components.
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